Quick Report Wizard - Part 1
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Abstract

Reports represent one of the most important functions in data management. A
Quick Report is the ideal way to offer your users the possibility of creating their own
reports to extend the custom reporting capabilities of your application. This
Technical Note revisits creating a custom interface for Quick Reports using 4D v11
SQL commands.

Part I of this Technical Note focuses on the interface and functionality of the Quick
Report Wizard. Part II will focus on the implementation and programming of the
sample database.

Introduction

You may ask what the purpose of recreating the interface of the Quick Report would
be. There are several advantages of doing so. In particular, you can control the
elements and their function as well as present your user with the appropriate
information in the context of the report. Some users may feel intimidated by the
prospect of building a report from scratch; in this case you may build some of the
elements of the report and have them complete it. All the options available to a
user in the 4D v11 SQL built-in Quick Report can be duplicated using the QR
commands.

Types of Reports

There are essentially two types of Quick Reports; List Reports and Cross-Tab
Reports. This Technical Note addresses both.

List Reports display records in a list with break levels where additional
mathematical operations can be performed. Cross-Tab Reports display information
as a two-dimensional table. You can display data from a data source as categories
that are functions of two other data sources.

Quick Report Plug-in

In order to create a Quick Report interface we need to use the Report Plug-in Area.
The functionality of this plug-in is similar to any other 4D v11 SQL plug-in. The
main difference is that it is not an external plug-in; it has been integrated into 4D
v11l SQL. As a result, there is no need to install it in the Plugins folder and
removing it is not an option.

The Report Plug-in is similar to other 4D v11 SQL Plug-ins that have been
integrated into 4D, such as Web Area or 4D Chart. To use the Report Plug-in, all
you have to do is create a form and add the Report Plug-in. In this Technical Note,



the Report Plug-in is displayed using the command DIALOG do build the custom

interface.
E When the solution matters Quick Report Wizard

Cancel

The Quick Report Environment

Selecting Quick Reports... from the Tools menu displays the Quick Report
environment. The User has a choice to build the report by making decisions about
the type of report, the data, the formatting, etc. This is referred to as the Manual
mode. The other possibility is to select the Wizard and follow a number of steps to
obtain similar results in a more structured approach. This Technical Note recreates
the functionality of the Quick Report environment using the Wizard model. A series
of steps guides the user to obtain the type of reporting they require.



®00 Quick Report

© 00 50+ 1+ 100 1« 150: 1+ 200 1+ 250: 1+ 300 1 + :350. 1 .« 400 1+ 450. 1 .+ 500 1+ 550. 1 .+ GO0 1+ 650 1 . 700: »

Title
Title
Detail
Grand total

\ Print Preview...' E ' Step 1 : Report Type Manual mode \( -]
_ DSelect the type of report you want to %
build. —
The report will be built dynamically at the top of this window. The
=—— Report Wizard is designed to help you create a report step-by-step,
but if you wish, you can go back to the manual mode without losing
any of the settings.
I 1 - Report Type | g ¢

The list report is the most common type of report.
X This type of report allows you to display different types of datain a
List list, and provides the ability to sort orders as well as perform
computations on them. Several types of presentations can be applied

to the report according to your needs. The final report can also be
printed or exported in a variety of output formats.

The cross-tab report is a type of report that displays an analysis of two
sets of numeric data. As with the list report, it is possible to perform
@ Cross table computations on the values, and to use predefined templates for the

presentation. The final report can be printed or exported in a variety of
output formats.

y’ a5

Quick Report Commands

4D v11 SQL offers over 40 commands to programmatically create and control all
the functions of a Quick Report. For more detailed information about these
commands, you can consult the Quick Report section of the 4D v11 SQL Language
Reference Manual or http://www.4d.com/docs/V6U/V6UO0039.HTM.

This Technical Note makes use of these commands to duplicate and enhance the
functionality of a Quick Report Generator.

List Reports in the Sample Database

The sample database included with this Technical Note allows you to create the two
types of reports described previously. Let’s examine the process for creating a List
Report step by step. In addition, the commands and methods utilized are also
described to give you a better idea of the process of building your own Quick Report
Wizard.



When you start the Quick Report Wizard database, a single dialog contains all the
interface elements necessary to create the report. The first screen allows you to
select the type of report, the main table and the records you want to include in your

report.

A0

E When the solution matters

Select the type of report you want to print:

@ List Report

To print a List Report only the fields that are going to be

printed.
Company Rank Revenue (Millions)
Exxon Mobil 1 442,851
Wal-Mart Stores 2 405,607
Chevron 3 263,159
ConocoPhillips 4 230,764
General Electric 5 183,207

For the selected table: | [Clients) |- ]

t 0500 1+ 100 1+ 450 1« 200 1 . 250 1 . 300 1
Title
Title

Detail
Grand total

Quick Report Wizard

() Cross-Tab Report

To print a Crosstab Report, three sets of values need to be defined:
the row, the column and one for computing the data.

Jan Feb Total

Exxon 200 330 530

Chevron 150 100 250

Grand Total 350 430 780

@ All Records [ 50 Clients ] Query
350 400 450 500 550 £00 650 700 750

Cancel Next

Let’s start with the List Report as our choice for type. The table is Clients and the
number of records is All Records (50 Clients). When we click Next, the first step in

our process appears.

To define the type of report use the or ser rEPORT XKIND COMMand.

To define the table use the gr seT TaRLE cOmmand.

Step 1: Select your fields and the sorting order

This is a crucial step in creating a List Report; you need to select the data to be
used in generating your report. A list of the fields in the main table allows you to
drag-and-drop the fields in the Quick Report Area. You can also display a
contextual Add menu in the Quick Report Area to insert fields. All the fields for
the selected table appear as choices. There may be cases where you do not



want to display all the fields. If that is the case, you can create a virtual
structure to hide tables or fields.

When using the drag-and-drop option, the value can be determined using prac
anD DrRoP PROPERTIES and detect where the object has been dropped using the or
Get drop column cOmmand. The result is a Longint.

If the number is negative, it indicates it was performed in an existing column;
therefore, you need to use or ceT INFO coLuMn tO retrieve its value and or skt
nFOR conumy to update it.

If the number is positive, it indicates the value was dropped in an empty
column. You can use or INSERT cOLUMN tO insert its value.

In addition to the main table, a drop down menu allows you to select ONE Table
or MANY Tables with all their corresponding fields. You can use a ONE Table and
use fields from MANY Tables. The Report Plug-in is able to detect the fact that
you selected a Many field. 4D v11 SQL parses the Many fields, detects the
deepest one (performs a reLaTE MaNY SELECTION) @nd runs the report based on
that table.

800

E When the solution matters

Select your fields and the sorting order:

You can insert, move, or replace your columns with fields or fomulas.

Fields

Drag-and-drop the following fields into your report or into the
Sorting order area. Use the contextual menu to insert formulas.

[Clients]State ‘
[Clients)Zip m

[Clients]Country
[Clients]Fortune500_Rank A
v

[Clients]Phone
| [Clients]Fortune500_Year

“
- |

| Current table only |

Quick Report Wizard

List Report

Sorting order

Drop those columns here that you wish to sort. Double-click on
the name to undo the drop.

[Clients]Fortune500_Rank

You can also move or hide your columns and rows.

+500¢ 1« :550¢ 1+ 600

®

HED @®

© 0+ 250 0+ A00: 1+ A50. 1+ 200: 1+ 250. 1 . 300: 1 . 350. 1 . 400 1+ 450 1 .
Title [Clients]Company_Narr [CIients]For(uneSOO_Ran‘ [Clients]Revenue_inMiIIiol
Title Company_Name Fortune500_Rank Revenue_inMillions
Detail
[Clients]Fortune500_Rank changed
Grand total

Cancel Back ‘ [ Next




Step 2: Define the values inside your break levels

The following tags can be inserted inside a cell for break levels:

#S
#N
#X
#A
#C
##N

Used to insert the SUM calculation in your break cell,
Used to insert the MIN calculation in your break cell,
Used to insert the MAX calculation in your break cell,
Used to insert the AVERAGE calculation in your break cell,
Used to insert the COUNT calculation in your break cell.
Used to insert the current value of the column whose number is N.

This tag does not work for picture values.

You can combine these tags in a unique sentence or use them on the same line.

800

#
#hz
Ex: ##5

E When the solution matters Quick Report Wizard

Define the values inside your break levels: List Report

You can define a computation on each break level or grand total line by selecting the cell and clicking on the appropriate icon in the
computation toolbar. You can also embed these values inside a cell. Embed values by writing a sentence that uses the following codes:

Value that generated the break level ##S Sum ##X  Max
Current value of the z th column ##A Average ##C Count
Current value for column 5 ##N Min

You can also check the 'repeated value' button in order to repeat your values when printing the breaks.

£ A« N o RO =

©

© 0+ 0500 0+ 00: 1+ A50: 1+ 200: 1+ 250: 1+ 300: 1+ 350: 1 . 400: 1 . 450: 1 . 500: 1 . 550: 1 . 600
Title [Clients]Company_Narr [CIients]For(uneSOO_Ran‘ [Clients]Revenue_inMiIIiol
Title Company_Name Fortune500_Rank Revenue_inMillions
Detail
[Clients]Fortune500_Rank changed
Grand total #itd
Cancel Back ‘ [ Next




Step 3: Define an action in your break levels

No action is defined in a break level by default. You may add a page break for a
break level or add extra spaces.

Select the whole line for the desired break level and display the Total spacing
dialog from the File or the contextual menu. This dialog allows you to specify an
action for when the break is executed. Keep in mind the break does not execute
if there’s nothing to print.

You can also set the spacing using the or GeT TOTAL SPACING @and QR SET TOTAL
SPACING cOmmands.

800
E When the solution matters Quick Report Wizard
Define an action in your break levels: List Report

You can define an action such as a form feed or re-print the titles after each break level.

Enter the following values to specify Break actions: « No action: 0
« Break page: 32000

+ Spacing of X points: X (from 1 up to 31999)

Break Action: 0 Get Action ‘ ‘ Set Action
© 0 50 1 00 1+ 50 1« 200 1+ 250+ 1+ 300 1 . 350: 1+ 400 1 . 450. 1 .+ 500 1 . 550 1 . 600
Title [CIiems]Company_Narr‘[CIien(sIFonuneSOO_Ran\[Clients]Revenue_inMiIIio\
Title Company_Name Fortune500_Rank Revenue_inMillions
Detail
[Clients]Fortune500_Rank changed
Grand total

Next

@ Cancel | Back l




Step 4: Define a format for your cells

List reports without formatting may be acceptable in some circumstances.
However, it is a better practice to format the data to improve legibility and
understanding. 4D v11 SQL provides you with predefined formats for text,
numerical, date and time values.

When defining your own formats you can use the #, 0, * and ~ characters. Each
of these will be replaced by the value in your report. For more information about
custom 4D formats please review Chapter 7 in the Design Reference , Fields and
Active Objects, in the Display Formats section. This document is available at:

http://4d.com/support/documentation.html

When your format has been established for a column, each value for that
column will be printed using that format in the detail and break levels as well.

For picture fields, check whether you are using the automatic width option and
the type of formatting. When automatic width is selected, the width is based on
the height of the image. If automatic width is deselected, the height is still
calculated based on the height of the image, but the width does not change.

0 00
E When the solution matters Quick Report Wizard
Define a format for your cells: List Report

The Quick Report needs to format your data.
If no format is chosen, it will use the default one in 4D. A format is defined for the whole column. You can use available formats that 4D
provides or use your own for text and numerical values.

If you want to define a format for your texts or numerical values, you can use the #, 0,* or A characters to define them. The characters defined
in your format will be replaced by one of the characters of the value to be printed. Be sure that you have enough characters in your format to
print the whole value. The # character will print the character, if any, while the other characters will print the character, if any, or a 0 or a space
or a * if there are no more characters available to be printed. Date, time and picture fields have pre-defined formats.

A format will be used for each value for this column, even if you do want to print it into another column when using the ##z defined in the
previous step.

i+ 050+ 1+ 100 1 . 150: 1 .+ 200: 1+ 250+ 1+ 300 1 . 350 1 . 400 1+ 450: 1 . 500+ 1 . 550 1 . £00:
Title ‘[Clients]Company_Nan' [Clients]Fortune500_Ran|[Clients]Revenue_inMillion:

Title Company_Name Fortune500_Rank Revenue_inMillions

Detail S ##0.00;- S  ##0.00
[Clients]Fortune500_Rank changed

Grand total #iC

@ Cancel Back Next
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Step 5: Define the style attributes for your cells

You can define the style attributes for each cell in your list report. The following
attributes are available:

* Font name: You can use the ront 15T command to retrieve a list of all
the Fonts and Font numbers installed in your system. 4D v11 SQL
requires the font number of the selected font.

* Size: The size must be between 1 and 128.

* Bold, Italic and Underline: Standard font properties.

* Main Color: Font color value.

* Justification: Left, centered, right or default justification from the
system.

 Background color: Each cell can have a background and alternate
background color. When an alternate background color is defined, the odd
lines are printed using the background color and the even lines are
printed using the alternate background color.

00
E When the solution matters Quick Report Wizard
Define the style attributes for your cells: List Report

Styles attributes can be defined for each cell.

You can define your own styles such as font name, size, bold, italic and underline attributes, main color, justification or background color.

The background color can be alternated.
The first color will be used when printing even lines while the alternate background color will be used for odd lines.

v ~|[|B 7 U | |
© 0+ 500 0+ A00. 1+ A50. ¢+ 200. 1+ 250. 1 + 300. 1 . 350. 1 . 400. 1 . 450. 1 . 500. 1 . 550. 1 . 00
Title [Clients]Company_Nan [Clients]Fortune500_Rar| [Clients]Revenue_inMillion:
Title Company_Name Fortune500_Rank Revenue_inMillions
Detail $###,##0.00;-$##%,##0.00
[Clients]Fortune500_Rank changed|
Grand total ##C

@ Cancel Back Next
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Step 6: Define a border for your cells

Selecting a cell a row or a column and displaying the contextual menu allows
you to define a border.

You can also use the or seT BorDER COmmand. It requires the cell coordinates.
The borders can be 2 points, 1 point, 2 point and "4 point.

Select a cell and click on the Load Settings option. The command or GET BORDER
is used to get the values and display them around the borders. You can change
the values and click on the Apply button when you're ready.

The List Report has five different types of borders:

Top border: This border appears at the top of the object. This border may
overwrite the settings of the bottom border of the previous object in the
same column.

Left border: This border is displayed at the left of the cell. This border
may overwrite the right border of the next object to the left on the same
line.

Right border: This border displays at the right of the object. This border
may be overwritten by the left border of the object to its right on the
same line.

Bottom border: This border is printed at the bottom of the object. This
border may be overwritten by the top border of the object defined on the
next line in the same column.

Center border: This border is printed between cells of the same type of
object.

12
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E When the solution matters Quick Report Wizard

Define a border for your cells: List Report

You can now define a border for a cell, a column, a line or for all cells.

To define a border, select one cell, choose a color or enter a color's value, define the cell width, select which borders to apply by clicking on the
borders below, then click on the Apply button. To load current settings, select a cell and click on the Load Settings button.

You can also use the default dialog from the contextual menu by selecting the Borders item.
This dialog will allow you to define a border for a cell, a column, a line, or for all cells.

1/4 pt Color(0)
| |

L4 pt | —
Color) | 1/4 pt Color(0) lr
e —————————

1/4 pt Color(0)

1/4 pt Color | 05  width | None ﬂ

Color(0)
Load settings Apply

ﬂ

File View Style Cells Columns

© 0 2501+ 1000 1+ 450 1+ 200+ 1+ 250: 1+ 300: 1 350. 1 . 400 1 . 450 1 . 500. 1 . 550. 1 . 600:
Title [Clients]Company_Nan|[Clients]Fortune500_Rai|[Clients]Revenue_inMillion]

Title Company_Name Fortune500_Rank Revenue_inMillions

Detail $#3#3,##0.00;-$###,##0.00
[Clients]Fortune500_Rank changed

[Grand total ##C

@ Cancel ‘ [ Back Next

Step 7: Define the width of your columns

When establishing how wide your columns are going to print, you can select
automatic width or select a fixed width. Automatic width may slow the printing
of your List Report, since 4D v11 SQL needs to calculate the maximum width of
each column. If you can define how wide your columns should be, especially
with text values, it is recommended to do so instead of using automatic width.

In the toolbar you can check or uncheck the automatic width for the column.

Programmatically, you can use or GET INFO COLUMN OF QR SET INFO coLUMN tO obtain
and set these values.

13



800

E When the solution matters Quick Report Wizard

Define the width of your columns: List Report

The width can be automatic or fixed. If you use the automatic feature, the Quick Report plug-in will compute automatically the size of the column
for you. If a fixed width has been defined, the current data to be printed will be formatted in the column according to the fixed width.

You may check the "Width" button in the toolbar to enable the automatic feature. You may uncheck it and resize the column if you prefer to have a
fixed width.

HER | m

© 0+ 50 0+ 00+ 1+ A50: 1+ 200+ 1+ 250: 1+ 300: 1+ 350: 1 . 400: 1 . 450: 1 . 500: 1 . 550: 1 . 600
Title ients]Company_Name |[Clients]Fortune500_Rar|[Clients]Revenue_inMillion:
Title Company_Name Fortune500_Rank Revenue_inMillions
Detail $###,#%#0.00;-$##%,##0.00
[Clients]Fortune500_Rank changed
Grand total ##C

@ v Cancel Back ' v Next

Step 8 - 9: Define the page header and footer for your report

Essentially the header and footer in a List Report operate the same exact way.
Defining a header or footer means that each prints once for each new page
printed.

The following information can be entered in the header or footer: Left side text,
center text and right side text. For each of these sections, you can also define
style attributes for the text.

You can also enter a picture to be printed in the header or footer.

When you want to print the page number you can use: #P. To print the current
date you can use: #D. To print the current time you can use: #H.

You can define the header and footer using or seT HEADER anND FOOTER. The QR GET
HEADER AND FoOTER command allows you to read the header/footer settings. Break
values for both commands are 1 for Header and 2 for Footer. You also need to
use the or seET TEXT PROPERTY and QrR GET TEXT PROPERTY tO set or read the text

14



properties of the text in the header or footer. These are the same commands
you can use for each cell, except you cannot assign a color to a footer or a
header. The break level humbers to be used are -4 for Header and -5 for Footer.

800

E When the solution matters Quick Report Wizard

Define the page header of your report:

List Report

You can define the page header by requesting the appropriate dialog in the 'File’ menu, item 'Header and Footer' from the menu bar in
the Quick Report area, or use the following panel:

Header
Left text Company by Fortune 500 Rank Font ‘ Verdana 4 ‘ Picture
Center text Height | 25 (O On the left
Right text Size [ 12 ® On the center
Style ™ Bold () On the right
[ nalic

File View Style Cells Columns

© 0+ 250 0+ 00: 1+ A50: 1+ 200 1 + 250 1 « 300 1 350: 1 . 400: 1 . 450: 1 . 500. 1 . 550. 1 . 600
Title [Clients]Company_Name |m[Clien(s]Revenue_inMiIIion:
Title Company_Name Fortune500_Rank Revenue_inMillions
|Detail $##H,#30.00;-$###,%#0.00)
|[Clients]Fortune500_Rank changed

|Grand total ##C

Cancel ‘ l Back ‘ l Next

Step 10: Generate your Report

The options to generate your report are: print to a printer, preview or export to
a text file, a 4D Chart or a HTML file. You can use a different template for your
HTML export. You can use the following tags to define your HTML template:

<html>
<head>

<meta http-equiv="Content-Type" content="text/html;charset=<!--
#4DQRCharSet-->">
</head>

<body bgcolor="#FFFFFF" text="#000000">

15



<table border=1>
<!--#4DQRHeader—-->

<tr>

<!-—#4DQRCol1-->

<td bgcolor="<!--#4DQRBgcolor-->">
<!--#4DQRFont—-->
<!--#4DQRFace-->

<!--#4DQRData-->

<!--/#4DQRFace-->
<!--/#4DQRFont-->

</td>
<!--/#4DQRCol1-->
</tr>

<!--/#4DQRHeader—->
<!-—#4DQRRoOwW——>
<tr>
<!-—#4DQRCol-->
<td bgcolor="<!--#4DQRBgcolor-->">
<!--#4DQRFont—-->
<!--#4DQRFace-->
<!--#4DQRData-->
<!--/#4DQRFace-->
<!--/#4DQRFont-->

</td>
<!--/#4DQRCol-->
</tr>
<!--/#4DQRRow-->
</table>
</body>
</html>

You need to use the or seT #rmML TEMPLATE command to modify the template.

From the Report plug-in, you cannot specify the destination file. Each time that
you want to create an HTML file, a dialog asking you where to save the file is
presented. However, you can still define by code where to write the file. This is a
parameter that you need to provide when you use the or ser pESTINATION
command.

16
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Generate your report: List Report

You can print a report, create a graph from a report, or export a report into a text file, or a HTML file. Select the final

destination from the 'File’ menu, then the 'Generate' item to generate the report. You can also click the following Text file
buttons:

A printer must be installed and available before printing the document. Graph
A print preview is only possible when the selected destination is a printer.
print p ¥ poss| : HTML file
Export your report into a text file. A dialog will ask you to choose a location.
Edit template
Generate a graph. A computation on a break level will be required.
Export your report into an HTML file. A dialog will ask you to choose a location. @

You can edit your own HTML template by clicking on the Edit template button. Print

File View Style Cells Columns

© 0+ 250 0+ A00: 1+ A50: 1+ 200: 1+ 250: 1+ 300: 1+ 350: 1 . 400: 1 . 450: 1 . 500: 1 . 550: 1 . 600
Title [Clients]Company_Name | [Clients]Fortune500_Rai [Clients]Revenue_inMillion:

Title Company_Name Fortune500_Rank Revenue_inMillions
Detail $###,##0.00;-$##%,##0.00
[Clients]Fortune500_Rank changed

Grand total ##C

Cancel Back

Cross-Tab Reports in the Sample Database

Now lets take a look at the process for creating a Cross-Tab Report step by step.
A Cross-Tab report can be divided into 3 columns and 3 rows.

Column 1 Column 2 Column 3
Row 1 A B C
Row 2 D E F
Row 3 G H I

For example cell A can be referred as Column 1 Row 1.

Some commands require a column number and a break level to designate the cell
you want to apply the command to. If you want to use these commands, you need
to provide the current column ID as the column number and the current row ID as
the break level.

For example, in order to use the command or seT ToTALS paTa with cell G, 1 should
be provided as the column number, and 3 as the break level.

17



As with the previous report you need to select the type of report. In this case, the

Crosstab Report. To define the report type, you can use the or SET REPORT KIND

command. You also need to select the Table. To define the current table, use the or

SET TABLE command.

A Cross-Tab Report requires 3 data sources. The first data source defines the

columns, the second defines the rows and the third is use to compute the

intersecting cells. For more information see Chapter 10 in the 4D v11 SQL Design

Reference, Quick Reports, available at:

http://4d.com/support/documentation.html

800
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Select the type of report you want to print:

() List Report

To print a List Report only the fields that are going to be

printed.
Company Rank Revenue (Millions)
Exxon Mobil 1 442,851
Wal-Mart Stores 2 405,607
Chevron 3 263,159
ConocoPhillips 4 230,764

| General Electric 5 183,207

For the selected table: | [sales) 55 ]

© 1+ 250 1+ 100: 1+ A50: 1« 200+ 1+ 250 1 « 300+ 1 -

Title ‘

Title ‘

Detail |

Grand total|

(*) Cross-Tab Report

Quick Report Wizard

To print a Crosstab Report, three sets of values need to be defined:
the row, the column and one for computing the data.

Cancel

Jan Feb
Exxon 200 330
Chevron 150 100
Grand Total 350 430
@ All Records 300 Sales
350: 1 + 400: 1 « 450 1 . 500+ 1 - . 600 1+

Total
530
250
780

Query

650 1 . 700. 1 . 750: |

Next

18



Step 1-2-3: Define a format for your cells

These are 3 different steps in the Demo Database to maximize the space. You
need to define the data sources for the columns, rows and calculations. You can
use the command or ser 1nrFOR corumn to define the sources. The command
requires the column number, data source, title and properties as parameters. In
the variables methods, we can use or GeT INFO conuMn before or SET INFO COLUMN.
This call is made to maintain preferences that are not altered by the data
source.

800
E When the solution matters Quick Report Wizard
Select a field for columns: Crosstab Report
Fields

This will define the titles of columns. Each record will be parsed and each value for this field may create a new column if the value does not
exist yet.

Select a field for columns
[Sales]Tracking_No Column 1 Column 2 Total
[Sales]Sales_ID p— —
[Sales]Client_ID

Line 1

[Sales)Sales_Amount Line 2
[Sales]Sales_Date ad Grand Total
" ™ v i i
| Current table and related fields 3
Drop your choice here: [[Sales]SaIes_Da(e |
|+ 0+ 250 0+ A00: 1+ A50: 1+ 200. 1+ 250: 1+ 300: 1+ 350. 1 . 400: 1+ 450: 1+ 500+ 1+ 550: 1+ £00: 1+ £50: 1 . 700 1 . 750. 1 . BOO: 1 . {
[Sales]Sales_Date Total
[Clients]Company_Name ([Sales]Sales_Amount =
- & Sum
Z Sum
Grand Total 5 sum Z Sum

@ Cancel Back ‘ ‘ Next
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Step 4: Select a computation for Data Source cell

4D v11 SQL parses each record and tries to resolve expressions defined for
columns, rows and data sources. Internal arrays are initialized and new values
added to these arrays. Values already present in the arrays only update the
Data source. 4D v11 SQL checks the type of calculation defined for the Data
Source cell and apply it to each occurrence. If there is nothing to be printed then
the cell remains empty. The choices for calculations are Sum, Count, Min, Max
and Average; incidentally, these are only available if the type of value defined
for the Data Source is compatible with the calculation.

800
E When the solution matters Quick Report Wizard
Select a computation for Data Source cell: Crosstab Report

Computation

The field previously defined in the Data area will be used to perform these computations.

The Data Source celll data is the intersection cell between a Column 1 Column 2 Total
column and a line.

You need to define a data source and at least one Line 1

computation for this area. ) , Line 2 —

If you do not provide a computation or nothing can be sl
computated, the cell will be empty. Grand Total

Select the defined cell and choose the computations you want to perform from the toolbar or from the contextual menu.

File View Style Cells Columns

© 0+ 50+ 1 . 100: 1+ A50: 1 .+ 200: 1+ 250: 1 .+ 300: 1 + 350: 1 . 400: 1 + 450: 1 + 500: 1 + 550: 1 » 600: 1 + 50: 1 . 700: 1 . 750: 1 . B800: 1 . |
[Sales]Sales_Date Total

[Clients]Company_Name ([Sales]Sales_Amount 5
- & Sum
Z.Sum

Grand Total 5 Sum 5 Sum

@ Cancel Back ‘ Next
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Step 5: Select a computation for the Total Column:

A Cross-Tab report can have a Total column defined by cells C and F. It is not
printed if no calculation has been defined for Cell F. Cell C is used for the title of
the column and F for the calculation.

Values for this column are not calculated based on the values for cell E but from
the data itself. This means that if you perform an average in Cells E and F, you
might think that the value for F is not correct; it's not an average on the values
that are printed in E. Values in F are computed from all values defined in each
record of the current selection.

You can use the gr seT ToTrans pata command to define a title of the contents of
this column.

000
E When the solution matters Quick Report Wizard
Select the a computation for the Total column: Crosstab Report

Computation

The field defined as data source will be used to perform these computations.

Total is the far right column.

N . X . . X Column 1 Column 2 Total
This column will not be printed if no calulation will be defined

Line 1
Line 2

Enter a new title for Total: Total Grand Total

Select the defined cell and choose the computations you want to perform from the toolbar or from the contextual menu.

File View Style Cells Columns

© 0+ 250 1+ A00: 1 + A50. 1 + 200- 1 + 250: 1 + :300- 1 + 350: 1 . :400: 1 + -450: 1 + 500: 1 + 550: 1 + 600: 1 + 650: 1 . 700: 1 + 750: 1 . 800: 1 . |
[Sales]Sales_Date Total

[Clients]Company_Name [ Sales]Sales_Amount -
- & Sum
Z.Sum

Grand Total = Sum Z Sum

@ v Cancel ' Back ' v Next
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Step 6: Select a computation for the Grand Total line

A Cross-Tab report can have a Grand Total line defined by cells G, H and I. It is
not printed if no calculation has been defined for Cell H. Cell I is not printed if no
calculation is defined by cell F. Cell G is used to insert a label for the Grand Total
line. Cell H contains the summary calculation for each column. The way the
Grand Total line is calculated is similar to the Total column. Values are
calculated from the data and not from the results from cell E. This also applies
to cells H and 1.

800
E When the solution matters Quick Report Wizard
Select a computation for the Grand Total line: Crosstab Report

Computation

The field defined as data source will be used to perform these computations.

Grand Total is the last line that will be printed. It will contain . . .
calculations per column. Column 1 Column 2 Total

This line will not be printed if no calulation will be defined. -
Calculations between Total and Grand Total will not be printed Line 1
if no calculation has been defined for Total and Grand Total [ Line 2
! ! | -
Enter a title for Grand Total: Grand Total L Grand Total i %

Select the defined cell and choose the computations you want to perform from the toolbar or from the contextual menu.

File View Style Cells Columns

© 01+ 250 1+ 00: 1 + A50. 1 + 200- 1 + 250. 1 + :300. 1 . 350: 1 . :400. 1 . :450: 1 . 500: 1 + 550: 1 + 600: 1 . £50: 1 . 700: 1 . 750: 1 . 800: 1 + |
[Sales]Sales_Date Total

[Clients]Company_Name ([ Sales]Sales_Amount -
- & Sum
Z Sum

Grand Total 5 Sum Z Sum

@ Cancel ' Back ‘ [ Next

22



Step 7: Select the sorting order

To sort the columns and rows of the Cross-Tab report, you can use the or st
sort command. It requires an array with column numbers to be sorted. To sort
columns pass the value 1. To sort rows pass the value 2. Pass 1 for ascending
order and -1 for descending order.

8 00
E When the solution matters Quick Report Wizard
Select the sorting order: Crosstab Report
Sorting order

You can now define sorting orders for rows and columns. Click on the folowwing buttons to choose the

Rows: () Do not sort Columns: () Do not sort
@ Sort in ascending order ) Sort in ascending order
() Sort in descending order O Sort in descending order
[+ ..50.1 .00 1 . 450. 1 . 200. 1 . 250 1 . 300 1 . 350. 1 . 400. 1 . 450- 1 . 500. 1 . 550 1 . 600 1 . §50- 1 . 700 1 . 750- 1 . 800- 1 . |
[Sales]Sales_Date Total
[Clients]Company_Name [Sales]Sales_Amount
- z Sum
Z.Sum
Grand Total 5 Sum 5 Sum

@ e | [ sk | [ N |
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Step 8: Formatting your data

You can use display formats as you would with a List report. Use the command
OR GET INFO coLuMN toO retrieve the current format and or seT 1NFO corumn to assign
a new format.

Reference numbers are : 1 for Columns (Cell B), 2 for Rows (Cell D) and 3 for
Data Sources (Cell E).

To define a format for your text or numerical values, you can use the characters
#, 0, *, or ~. Each character defined in your display format is replaced by one
of the characters of the value in the report. Be sure you have enough characters
in your format to display the value in its entirety. The # character displays the
value's character, if any, while the other characters (0, *, or ) display the
value's character, if any, or a 0, a space, or a * if there are no more characters
in the value to be displayed. Date, time and picture fields have pre-defined
formats. You cannot create your own format for these types of data.

000
E When the solution matters Quick Report Wizard
Formating your data: Crosstab Report

Define the format of your cells

You can now define default fomats from the contextual menu or enter your custom format below

Rows: applied for row titles
Columns: applied for column titles
Data source: | S### ##0.00,-S### ##0.00 applied for values displayed in cells, grand total and total

The Quick Report needs to format your data. If no format is chosen, it will use the default one in 4D.
A format is defined for the whole column. You can use available formats that 4D provides or use your own for text and numerical values.

© 1+ .50 1+ 00: 1 + A50. 1 + 200- 1 + 250. 1 + :300. 1 . 350: 1 . :400. 1 + :450: 1 . 500: 1 + 550: 1 + 600: 1 + 650: 1 . 700: 1 . 750: 1 . 800: 1 + |
[Sales]Sales_Date Total

[Clients]Company_Name [Sales]Sales_Amount .
- & Sum
Z Sum

Grand Total Z Sum Z Sum

|
| Cancel Back Next
|
|
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Step 9: Define the style attributes for your cells

You can define the style attributes for each cell in your Cross-Tab report, similar
to the List Report. The following attributes are available:

* Font name: You can use the ront L1sT command to retrieve a list of all
the Fonts and Font numbers installed in your system. 4D v11 SQL
requires the font number of the selected font.

* Size: The size must be between 1 and 128.

* Bold, Italic and Underline: Standard font properties.

* Main Color: Font color value.

* Justification: Left, centered, right or default justification from the
system.

 Background color: Each cell can have a background and alternate
background color. When an alternate background color is defined, the odd
lines are printed using the background color and the even lines are
printed using the alternate background color.

You cannot assign hits directly to cell I. Settings defined for cell H are
automatically applied to cell I.

e 0O

E When the solution matters Quick Report Wizard

Define the style attributes for your cells: Crosstab Report

Styles attributes can be defined for each cell.
You can define your own styles such as font name, size, bold, italic and underline attributes, main color, justification, or background color.

The background color can be alternated. The first color will be used when printing even lines while the alternate background color will be used
for odd lines.

Verdana vl [~ 1 Uil Eli = = % %

* 1+ 50+ 0« 00 1+ 50 1+ 200: 1+ 250: v+ 300: 0+ .+ 350 0 .+ 400 0+ 450 1+ 500¢ 0« 550 1« 600: 1« 650: 1« 700 v .+ 750: 0 . 800 0
[Sales]Sales_Date Total

[Clients]JCompany_Name [Sales)Sales_ Amount -
Z Sum = Sum

Grand Total 5 sum 5 sum

@ Cancel Back Next
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Step 10: Define a border for your cells

Select a cell, a row or a column to display the border dialog from the contextual
menu. You can use the QR SET BORDER command to define a border. You need
to pass the cell coordinates to apply the border attributes. The border thickness
can be 2 points, 1 points, 2 point, ¥4 point.

Select a cell and click on the Load Settings option. The command or GET BORDER
is used to get the values and display them around the borders. You can change
the values and click on the Apply button when you’re ready.

The Cross-Tab Report has five different types of borders:

* Top border: This border appears at the top of the object. This border may
overwrite the settings of the bottom border of the previous object in the
same column.

* Left border: This border is displayed at the left of the cell. This border
may overwrite the right border of the next object to the left on the same
line.

* Right border: This border is displayed at the right of the object. This
border may be overwritten by the left border of the object to its right on
the same line.

* Horizontal Center border: This border is printed horizontally between cells
of the same type of cell.

» Vertical Center border: This border is printed vertically between cells of
the same type of cell.

You can define a border for all of these cells.

A Cell in the Quick Report area may, in fact, turn into many cells when the
report is printed. For example, we know that when printed:

* Cell B is in fact represented by many columns titles. The number of
columns depend on the number of values computed for column titles.

e Cell D is also be printed into many row titles. The number of rows depend
on the number of values defined for Cell D.

* There are many Cell E that will be printed. That would be a matrix based
on the number of items defined for Cell B and D.

* Cell Fis similar to Cell D, i.e. many rows defined within Cell F.

* Cell H is similar to Cell B.

When assigning a border to each cell, we are just going to assign a border to
this type of cell. It is useless to define a center border for Cell A, C or E since
they are printed once.

But Cell B, E and H may contain many columns. It in this case that we can
define and use a vertical centered border to separate each column within these
cells, while Top, Left, Right and Bottom borders define the limits of each cells.
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Thus, Cell D, E and F may contain many rows. We can define and use an
horizontal centered border to separate each rows within these cells, while Top,
Left, Right and Bottom borders define the limits of each cells.

You cannot define a border for Cell I. This cell uses the same settings defined for
Cell H.

000

E When the solution matters

Define a border for your cells:

Quick Report Wizard

Crosstab Report

You can now define a border for a cell, a column, a line or for all cells.
To define a border, select one cell, choose a color or enter a color's value, define the cell width, select which borders to apply by clicking on
the picture's borders below, then click on the Apply button.

You can also use the default dialog from the contextual menu by selecting the Borders item. This dialog will allow you to define a border for
a cell, a column, a line, or for all cells.

Left:1/4 pt Color(0) Width | None )
Top:1/4 pt Color(0)
Right:1/4 pt Color(0)

Bottom:1/4 pt Color(0) v

O Color | 0%

>

To load current settings, select a cell and click on the Load Settings button. Load settings Apply

File View
s 105001 .

Cells  Columns
150 1+ 200: 1« 250+ 1+ 300¢ 1

Style
1000 1 -

350: 1 . 400+ 1 450 1 + 500 1 + '550: 1 + 600 1 : 50: 1 . 700 1 . 750 1 . 8OO 1 : |

[Sales]Sales_Date

Total

[Clients]Company_Name

[Sales)Sales_Amount
Z Sum

-

Sum

Grand Total

Z sum

Z sum

Cancel Back Next

Step 11: Define the width of your columns

When establishing how wide your columns are going to print, you can select
automatic width or select a fixed width. Automatic width may slow the printing
of your List Report, since 4D v11 SQL needs to calculate the maximum width of
each column. If you can define how wide your columns should be, especially
with text values, it is recommended to do so instead of using automatic width.

In the toolbar you can check or uncheck the automatic width for the column.
Programmatically, you can use or GET INFO COLUMN OF QR SET INFO coLUMN to obtain
and set these values. Column numbers are 1, 2 or 3.
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E When the solution matters Quick Report Wizard

Define the width of your columns : Crosstab Report

The width can be automatic or fixed. If you use the automatic feature, the Quick Report plug-in will compute automatically the size of the
column for you. If a fixed width has been defined, the current data to be printed will be formatted in the column according to the fixed width.

You may check the "Width" button in the toolbar to enable the automatic feature. You may uncheck it and resize the column if you prefer to
have a fixed width.

© 0+ 50+ 1 . 100: 1+ A50: 1 .+ 200: 1+ 250: 1 + 300: 1 + 350: 1 . 400: 1 + 450: 1 + 500: 1 + 550: 1 . §00: 1 : 50: 1 » 700: 1 . 750: 1 . B0O: 1 . |
[Sales]Sales_Date Total

[Clients]Company_Name [Sales)Sales_Amount -
Z sum - Sum

Grand Total 5 sum 5 sum

@ Cancel Back Next

Step 12 - 13: Define the page header and footer for your report

Essentially the header and footer in a Cross-Tab Report operate the same exact
way. Defining a header or footer means that each prints once for each new page
printed.

The following information can be entered in the header or footer: Left side text,
center text and right side text. For each of these sections, you can also define
style attributes for the text.

You can also enter a picture that is printed in the header or footer.

When you want to print the page number you can use: #P. To print the current
date you can use: #D. To print the current time you can use: #H.

You can define the header and footer using or seT HEADER anND FOOTER. The QR GET
HEADER AND FoOTER command allows you to read the header/footer settings. Break
values for both commands are 1 for Header and 2 for Footer. You also need to
use the or ST TEXT PROPERTY and QrR GET TEXT PROPERTY tO set or read the text
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properties of the text in the header or footer. These are the same commands

you can use for each cell, except you cannot assign a color to a footer or a
header. The break level humbers to be used are -4 for Header and -5 for Footer.

M)

8.0C
E When the solution matters

Define the page header of your report:

Quick Report area, or use the following panel:

Header

You can define the page header by requesting the appropriate dialog in the 'File' menu, item 'Header and Footer' from the menu bar in the

Quick Report Wizard

Crosstab Report

Left text Sales by Date and Company

Font | Verdana

Q Picture

Center text Height 25 (O On the left
Right text Size 12 ® On the center
style W Bold () On the right
] italic
O Underline Set Header
File View Style Cells Columns
[ 1. .50. 1. 400 1 . 150 1 . 200 1 + 250+ 1 + 300+ 1 + 350+ 1 + 400 1 + 450 1 + 500 1 + 550 1 « 600 1 + 650: 1 + 700: 1 + 750: 1 . 800: 1 . |
[Sales]Sales_Date Total
[Clients)Company_Name [Sales])Sales_ Amount
T Sum P Sum
Grand Total 5 sum 5 sum
l Cancel | | Back ] l Next |
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Step 14: Generate your Report

This step is similar to generating your List Report. The options to generate your
report are: print to a printer, preview or export to a text file, a 4D Chart or a
HTML file. You can use a different template for your HTML export. For more
information about Editing the HTML template, see the List Reports Step 10.

e 0N
E When the solution matters Quick Report Wizard
Define how to generate your report: Crosstab Report

You can print a report, create a graph from a report, or export a report into a text file, an HTML file, or into a 4D
View window. Select the final destination from the 'File' menu, then the 'Generate' item to generate the report.

Text fil
You can also click the following buttons: EXTTE
. . ) i Graph
A printer must be installed and available before printing the document. L
A print preview is only possible when the selected destination is a printer. HTML file

Export your report into a text file. A dialog will ask you to choose a location.
port vt p 9 ¥ Edit template

Generate a graph. A computation on a break level will be required.

Print Preview
Export your report into an HTML file. A dialog will ask you to choose a location.

You can edit your own HTML template by clicking on the Edit template button. | Print

File View Style Cells Columns

.1« 500 1+ 100: 1+ A50: 1 .+ 200+ 1 + 250: 1 « 300: 1 + 350: 1 .« 400: 1 « 450: 1 « 500: 1 + 550: 1 + 600: 1 + 50: 1 « 700: 1 « 750. 1 . 800: 1 . |
[Sales]Sales_Date Total

[Clients]Company_Name [Sales)Sales_Amount -
Z Sum = Sum

Grand Total 5 sum 5 sum

Cancel Back

Conclusion

This Technical Note creates a Quick Report Wizard using the built-in 4D v11SQL
Quick Report commands. Quick Reports can be used to provide your users with a
powerful reporting tool that can complement the custom reports in your application.
By replacing the Quick Report capability in 4D v11 SQL Release 4 with a custom
Quick Report Wizard, you can accomplish a higher level of control as well as
minimize the complexity of presenting information in a number of different formats
and styles.
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